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Chapter 1. Introduction

Overview of the Sterling Business Intelligence Component
The IBM Sterling Business Intelligence component is an optional component,
providing powerful analytic and performance metrics that interface with the IBM
Sterling Selling and Fulfillment Foundation data set. The Sterling Business
Intelligence component allows you to explore and analyze a multi-enterprise order,
inventory, or catalog data. You can then identify performance trends and make
consistent, coordinated decisions to strengthen your extended enterprise and value
chain relationships.

The Sterling Business Intelligence component is delivered through a partnership
with Cognos® Corporation. The goal of the Sterling Business Intelligence
component is to enhance the value of the Sterling Selling and Fulfillment
Foundation by providing operational and analytical reporting capabilities to its
users, suppliers, and partners.

Cognos Product
The Sterling Business Intelligence component integrates with Cognos 8 Business
Intelligence, Cognos' web-enabled client-side reporting tool used for creating and
managing ad-hoc and scheduled reports.

Cognos 8 Business Intelligence includes:
v Query Studio - enables you to create ad-hoc reports through a graphical user

interface and save the reports in a variety of formats, such as PDF, Excel,
real-time reports, or prompted reports.

v Report Studio - used to create managed reports that are maintained, reused, and
require a higher level of complexity than a report produced in Query Studio.

v Analysis Studio - enables you to create ad-hoc cross-tab reports based on the
multi-dimensional data sources.

The Sterling Business Intelligence Component
The Sterling Business Intelligence component is delivered with the following:
v Data Model
v Sample Reports
v Custom Files

The Sterling Business Intelligence Data Model is a metadata model created using
Framework Manager. This Data Model is used to build Cognos 8 reports. The
reports generated by Report Studio are viewed using Cognos Connection. Cognos
Connection is used for administering security.

Sterling Business Intelligence: Data Model
The Data Model provided by Sterling Business Intelligence is the base for creating
reports and queries.

Sterling Business Intelligence: Sample Reports
The following sample reports are included with the Sterling Business Intelligence
component:
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v Sample Backlog Summary Report provides visibility into sales orders that have
been in certain fulfillment statuses for a specific period of time.

v Sample Days of Supply Report provides visibility into the estimated number of
days the inventory supply will be available, and the total supply and demand.

v Sample Goods in Transit Report provides visibility into transfer orders and
procurement orders whose delayed shipment impacts the shipment of an
outbound order.

v Sample Invoice Collections Report provides visibility into the total amount
invoiced and the total payments for each invoice type.

v Sample Open Order Report provides high-level visibility into unshipped orders
grouped by enterprise, buyer, and requested ship date. This report is utilized by
operational users of the Sterling Selling and Fulfillment Foundation to provide
information detailing orders during their fulfillment cycle.

v Sample Orders on Hold Report provides visibility into the number of sales
orders, purchase orders, and transfer orders that are on hold and unresolved.

v Sample Returned Products Report provides visibility into the ten most
frequently returned items for an enterprise within a specific period of time,
based on quantity.

v Sample Top 10 Products Report provides visibility into the 10 most frequently
purchased products within a specified time period.

v Sample Unshipped Orders Report provides visibility into the requested order
releases for a specific day.

Sterling Business Intelligence: Custom Files
The custom files (located in <ANALYTICS_HOME>/custom) are used to enhance the
user's experience of Analytics. See Chapter 2, “Installing and Configuring Sterling
Business Intelligence,” on page 3.

Sterling Business Intelligence and Cognos Integration
The Sterling Business Intelligence component provides direct access to the Cognos
Connection. When you launch Sterling Business Intelligence, the Sterling Selling
and Fulfillment Foundation-customized Cognos Connection is accessed. The
Cognos Connection is then used to launch reports. You must have authorization to
perform these functions.
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Chapter 2. Installing and Configuring Sterling Business
Intelligence

Cognos Setup
Before using the IBM Sterling Business Intelligence component, install the Cognos
products from the following Cognos CDs:
v IBM® Cognos 8 Business Intelligence Server (specification for operating systems,

such as 64 bit Windows)
v IBM Cognos 8 Business Intelligence Modeling (operating system)
v IBM Cognos 8 Supplementary Language Documentation (optional)

The following Cognos products should be installed in accordance with Cognos
installation instructions for each product:
v Cognos 8 Business Intelligence
v Framework Manager

If you are installing all Cognos products on one machine, install them in the order
presented here. When installing the LDAP server, use the same settings used to
configure the IBM Sterling Selling and Fulfillment Foundation.

Depending on your usage (volume, users, data), Cognos recommends different
configurations for the various servers used in this setup. Follow the
recommendations to avoid setup-related performance issues. For sample server
sizing guidelines, see “Cognos Server Sizing Requirements” on page 53.

Cognos Setup: Security Setup
The Sterling Business Intelligence component does not ship with the security
enabled because it would complicate the deployment at a client site. All of the
Sterling Selling and Fulfillment Foundation reports are created using Anonymous
User privileges. It is recommended that you enable security for the various Cognos
components and subsequently the Sterling Business Intelligence component after
they are installed.

Cognos Setup: Access Manager
The Access Manager provides authentication information for users. It also provides
a level of data access control by allowing the setup of User Classes and Groups.
All the users of Sterling Business Intelligence are set up in Access Manager, which
provides access configuration for data sources and other Cognos servers.

Access Manager and Sterling Business Intelligence User
Independence

The user and user group setup in the Sterling Selling and Fulfillment Foundation
are not linked to the user and user class setup in Cognos' Access Manager. Nor are
they synchronized between the two products. This is not possible because of the
proprietary nature of the Cognos LDAP storage scheme.

The users and user groups for the Sterling Selling and Fulfillment Foundation
must be maintained independently of the users and user classes for Sterling
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Business Intelligence. This is required because each user in Sterling Selling and
Fulfillment Foundation may not have access to the Sterling Business Intelligence
component or some users of the Analytics may not have access to the other
components of the Sterling Selling and Fulfillment Foundation . Additionally, it is
necessary that users common to both the Sterling Selling and Fulfillment
Foundation and Sterling Business Intelligence have the same user identifier and
password setup. Otherwise that user does not have seamless access to Sterling
Business Intelligence from the Application Console.

Cognos Setup: User Setup
The Sterling Selling and Fulfillment Foundation uses the concept of user groups
and organizations. User classes in Access Manager also support a hierarchical
structure. For visual consistency and ease of understanding, it is recommended
that you create Analytics Users and User Classes in Access Manager who
correspond to the Users and User Groups in the Sterling Selling and Fulfillment
Foundation as depicted in Figure 1.

You can also set up the following user classes in Access Manager that relate to the
roles played by an organization in the Sterling Selling and Fulfillment Foundation :
v Hub
v Enterprise

Figure 1. Cognos Users
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v Buyer
v Seller
v Carrier

Cognos 8 Business Intelligence
The reporting component does not ship with security enabled. Cognos Connection
should be used to enable security for these components.

Implementations must use the Sterling Selling and Fulfillment Foundation
Authentication Mechanism to authenticate users for viewing reports.

The database for content store for Oracle must have either UTF-8 or UTF-16
encoding. For more information about creating the database for content store, see
the Cognos documentation at: http://support.cognos.com/.

You can copy the Oracle thin driver to <COGNOS_HOME>/webapps/p2pd/WEB-INF as
classes12.jar. For more information about Oracle or DB2® drivers, see the Cognos
documentation at: http://support.cognos.com/.

Since Cognos 8 cannot access the <INSTALL_DIR>/properties/ folder, you can
include the connectivity information for the Sterling Selling and Fulfillment
Foundation in the <ANALYTICS_HOME>/bin/analytics.properties file.

Setting Up the Sterling Selling and Fulfillment Foundation
Authentication Mechanism

About this task

To set up the Sterling Selling and Fulfillment Foundation Authentication
Mechanism:

Procedure
1. Launch Cognos Configuration.
2. Go to Security > Authentication.
3. Add a new resource Namespace "sscap" of the type Custom Java Provider.

4. Assign namespace ID sscap to this namespace resource.
5. Assign com.yantra.authenticator.YantraAuthentication Java class name.

Results

Before applying the above configuration changes and restarting the Cognos
Service, complete the steps specified in “Deployment of Sterling Business
Intelligence Reports: An Overview” on page 17.

Setting Access to Cognos Administration and Reporting
To help increase the security of your business systems and data, with the Sterling
Selling and Fulfillment Foundation, you can selectively assign access to Cognos
administrative functions, reports, folders, and packages. The Sterling Business
Intelligence Administrator IBM Sterling Application Platform resource is used to
assign permissions to Cognos.

Setting up access requires the following:
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v Controlling access to Cognos Administration (set the permissions for the Sterling
Business Intelligence Administrator resource in the Sterling Selling and
Fulfillment Foundation Applications Manager and remove the Everyone group
from the Cognos System Administrator role)

v Controlling access to Cognos reports, folders, and packages (after the above task
is completed, only Administrators can set permissions for reports, folders and
packages)

Controlling Access to Cognos Administration
About this task

The first task in limiting user access to Cognos administrative functionality is to
grant permissions to the Sterling Business Intelligence Administrator resource in
the Sterling Application Platform. You must have security groups created in the
Sterling Selling and Fulfillment Foundation prior to completing this task.

Procedure
1. In the Sterling Selling and Fulfillment Foundation Applications Manager, select

Application → Sterling Application Platform.
2. From the tree in the application rules side panel, select Security → Groups. The

Groups window displays in the work area.
3. Select the group to be given permissions to access the Cognos screens.
4. From the Permissions screen, select Applications → Sterling Business

Intelligence → Business Intelligence Admin, as shown in Figure 2.

5. Right-click Business Intelligence Adminand select Grant All.
6. Click Save.

Results

The second task in limiting user access to Cognos administrative functionality is to
make two changes to the System Administrator role in Cognos, as described in
“Editing the System Administrator Role in Cognos.”

Editing the System Administrator Role in Cognos
The second task in limiting access to Cognos administration functionality is to
make two changes to the System Administrator role in Cognos. The two changes

Figure 2. Setting Entity Permissions in the Sterling Selling and Fulfillment Foundation
Applications Manager
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are described in “Adding the sscap/SYSTEM Group” and “Removing the Everyone
Group from the Sys Admin Role” on page 9. You can only complete this task after
you set access to Cognos administration (as described in “Adding the
sscap/SYSTEM Group.”

When a user launches Cognos Connection through the Console, all user groups to
which that user belongs are displayed. If the user has permission to access the
Sterling Business Intelligence Administrator, the user sees all groups defined in the
database and an additional group called sscap/SYSTEM. Otherwise, the user sees
only the groups to which he belongs.

In Cognos, by default, all users have administrative capabilities because the
Everyone group (which includes all users) is included in the System Administrator
role.

Adding the sscap/SYSTEM Group
About this task

Note: You must complete this task before deleting the Everyone group (see
“Removing the Everyone Group from the Sys Admin Role” on page 9).

When you grant BI Admin rights to a user in the Sterling Selling and Fulfillment
Foundation Applications Manager, a new group called SYSTEM is displayed in the
user's list of groups under the sscap namespace in Cognos. Add this
sscap/SYSTEM group to the System Administrator role in Cognos:

Procedure
1. Start your Web browser and enter the URL of your Cognos applications (the

default is http://localhost/cognos8).
The Cognos 8 home page displays.

2. Click Cognos Connection.
3. Log in to the Cognos Connection portal as a System Administrator.
4. Locate sscap in the list of roles, and click sscap.

5. Locate SYSTEM in the list, and click in the Action column.
6. The Set Properties - SYSTEM screen displays. Select the Permissions tab.
7. Check the Override the access permissions acquired from the parent entry

checkbox, as shown in Figure 3 on page 8.
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8. Click Add. The Select Entries - System screen displays.
9. Click sscap. The screen shown in Figure 9 on page 11 displays.

10. In Available Entries, select the System checkbox and click the arrow to move
it to Selected Entries. Click OK. The Set Properties - System screen displays,
as shown in Figure 4.

Figure 3. Set Properties - SYSTEM

Figure 4. Set Properties - SYSTEM
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Removing the Everyone Group from the Sys Admin Role
About this task

After adding the sscap/SYSTEM group to the System Adminstrator role, remove
the Everyone group from the System Administrator role:

Procedure
1. Log in to the Cognos Connection portal as a System Administrator.
2. Go to Tools → Directory and select the Cognos namespace.
3. Locate System Administrators in the list of roles, and click in the Action

column.
4. Select the Members tab, as shown in Figure 5. Select Everyone, and click

Remove.

Results

The result is that only users who have permission to access the Sterling Business
Intelligence Administrator have administrative capabilities in Cognos.

Controlling Access to Cognos Reports, Folders, and Packages
About this task

The second part of controlling Cognos access through Sterling Selling and
Fulfillment Foundation is to set specific permissions to entries in Cognos.

Procedure
1. In Cognos Connection on the Capability screen, as shown in Figure 6 on page

10, locate the entry for which you want to set access permissions.

Figure 5. Removing Everyone Group
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2. Click next to the desired entry to display the corresponding Set Properties
menu. Click Set Properties. The Set Properties screen displays.

3. In the Set Properties screen, select the Permissions tab.
4. Choose whether to use the permissions of the parent entry or select

permissions specifically for the entry:
v To use the permissions of the parent entry, clear the Override the access

permissions acquired from the parent entry option. If you are prompted to
use the parent permissions, click OK in the prompt dialog. Click OK on the
Set Properties screen.

v To set access permissions for the entry, select the Override the access
permissions acquired from the parent entry option, as shown in Figure 7.
Proceed to step 5.

5. To remove an entry from the list, select it and click Remove.

Figure 6. Capabilities - Select Functionality

Figure 7. Set Properties - Permissions
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6. To specify a new entry for which you want to grant or deny access, click Add.
7. The screen shown in Figure 8 displays. Click sscap.

8. The screen shown in Figure 9 displays. In Available Entries, select the
SYSTEM checkbox and click the arrow to move it to Selected Entries.

Figure 8. Select Entries

Figure 9. Select Entries
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9. Select entries using one of the following methods:
v To choose from the listed entries, click the appropriate namespace, and

select the users, groups, or roles.
v To enter new names, click Type and type the names of the groups, roles, or

users into the Entries field. Separate multiple entries with a semicolon (;), as
shown in the following example and in Figure 10.
For example: sscap/SYSTEM;Cognos/Everyone

10. Click the right-arrow to move entries to the Selected entries box and click OK
when done. You return to the Permissions tab, as shown in Figure 11 on page
13.

Figure 10. Selecting Entries
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11. Click add. You return to the Select entries screen, as shown in Figure 8 on
page 11.

12. Select sscap and then click the arrow to move sscap to Selected Entries. Click
OK. You return to the Permissions tab, as shown in Figure 11, with sscap
added to the Name column.

13. To specify permissions for a user, group, or role, select the appropriate
checkbox in the Name column and then select permissions checkboxes in the
Grant or Deny columns. The icon next to each user, group, or role in the
Permissions column represents the type of access granted or denied. Repeat
this step for each user, group, and role.

14. If you want to replace the existing permissions of the child entries with the
permissions you set for this entry, in the Option section, select the Delete the
access permissions of all child entries check box. This option appears only
with the entries that are containers.

15. Click OK.

User Authentication Between Cognos and Sterling Selling and
Fulfillment Foundation

In Sterling Business Intelligence, the YantraAuthenticationServlet authenticates the
user credentials being passed from Cognos. The servlet resides on the Sterling
Selling and Fulfillment Foundation server and does the following:
v Authenticates the user
v Provides information about user details/user groups
v Verifies that the user is a Cognos Administrator and returns user groups based

on the user resource permissions

Note: The data that the user can see in Cognos is not restricted by any data
access policies in Sterling Selling and Fulfillment Foundation.

Figure 11. Granting Permissions
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The following table contains the interfaces provided by Cognos that are used for
authentication:

Table 1. Cognos Authentication Interfaces

Interface Description

com.cognos.CAM_AAA.authentication.
INamespaceAuthenticationProvider2

Main interface. Must be implemented for authenticating users to
log in to the Cognos applications. YantraAuthentication is the
implementation class.

com.cognos.CAM_AAA.authentication.IAccount Interface that holds user information. YantraAccount is the
implementation class.

com.cognos.CAM_AAA.authentication.IGroup Interface that holds user group information. YantraGroup is the
implementation class.

com.cognos.CAM_AAA.authentication.IVisa Interface that holds user information such as user details/user
groups and user roles. YantraVisa is the implementation class.

The following diagram illustrates the Cognos authentication process flow:
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Isolating the Sterling Business Intelligence Data from
Analytics

About this task

Typically, users who use Sterling Business Intelligence and Cognos prefer to
separate the Sterling Business Intelligence data from Analytics and grant read-only
permissions to the Cognos data source because:
v Users do not want to risk the unauthorized usage of the database user name or

password or both of the Sterling Selling and Fulfillment Foundation in Cognos.
v If the user name or password or both of the Sterling Selling and Fulfillment

Foundation changes, the Cognos data source must be modified.
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To overcome these limitations, users must create and expose tables without having
the need for the Sterling Selling and Fulfillment Foundation user name or
password or both.

To separate the Analytics data from the Foundation tables:

Procedure
1. Grant select privileges to a non-Sterling Selling and Fulfillment Foundation

administrative user (for example, yanalytics).
2. Create synonyms under the yanalytics schema.
3. Create or modify the Cognos data source to point to the yanalytics schema.

Sterling Business Intelligence Setup
About this task

Before using the Sterling Business Intelligence component, you must perform the
following steps:

Procedure
1. Install Sterling Business Intelligence:

v Place the Sterling Business Intelligence installation CD in the appropriate
drive.

v From the installation CD, copy the SCIInstallWizard.jar file to your home
directory or base directory and change to that directory.
If you are using FTP to copy the files, verify that your session is set to binary
mode.

v To begin the installation, type the absolute path to the JDK directory,
followed by the command:

<JAVA_HOME>/bin/java -Xmx512m -jar SCIInstallWizard.jar

v When the installer opens, follow the directions.
2. Run scripts to install the custom files. See “Sterling Business Intelligence Setup:

Run Custom Scripts on Windows.”

Sterling Business Intelligence Setup: Run Custom Scripts on
Windows

About this task

To install a set of customized Web pages and images that enhance the users'
experience of the Sterling Business Intelligence Web component and to enable
Sterling Selling and Fulfillment Foundation branding in this installation, you must
set the environment variables for COGNOS_HOME and ANALYTICS_HOME in
the Image_Setup.bat script, as follows:

Procedure
1. Set the environment variables for SKIN_DIR in the Image_Setup.bat script.
2. Images: Run <ANALYTICS_HOME>\scripts\Image_Setup.bat. This copies some

images of Sterling Business Intelligence over the Cognos 8 images.
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Sterling Business Intelligence Setup: Run Custom Scripts on
UNIX

About this task

To install a set of customized Web pages and images that enhance the users'
experience of the Sterling Business Intelligence Web component and to enable
Sterling Selling and Fulfillment Foundation branding in this installation, you must
set the environment variables for COGNOS_HOME and ANALYTICS_HOME in
the $ANALYTICS_HOME/scripts/image_setup.sh script, as follows:

Procedure
1. Set the environment variables for SKIN_DIR in the image_setup.sh script.
2. Images: Run $ANALYTICS_HOME/scripts/image_setup.sh. This copies some

images of Sterling Business Intelligence over the Cognos 8 images.

Configuring Cognos to Run with Sterling Selling and Fulfillment
Foundation

About this task

Before running Cognos Connection with the Sterling Selling and Fulfillment
Foundation, you must ensure to:

Procedure
1. Set up the Cognos components as described (see “Cognos Setup” on page 3 ).
2. Deploy reports for Sterling Business Intelligence (see “Deploying Reports” on

page 45).
3. Modify your customer_overrides.properties file (see “Required Properties

Modifications to Launch Analytics” on page 19).

Deployment of Sterling Business Intelligence Reports: An
Overview

About this task

Ensure that the following tasks have been completed:

Procedure
1. Cognos Connection has been installed.
2. The content repository has been created through the Cognos Configurator.
3. Data Sources have been created using Cognos Connection, each named as

follows:
v smcf-meta

v smcf-config-default

v smcf-transaction-default

v smcf-masterdata-default

Note: The Data Sources are ideally set with isolation level set to Read
uncommitted.
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Results

You can optionally create multi-schema data sources at this time for transaction
and master data schema types, following this pattern:

smcf-<transaction|masterdata>-<pk_prefix>

For example:

smcf-transaction-01

smcf-masterdata-02

If you are using a single schema deployment, the four data sources must point to
the same database. However, if you are using a multi-schema deployment, the four
data sources should point to the configured schemas. For more information about
primary key prefixes and multi-schema features, see the Selling and Order
Management Foundation Multitenant Enterprise Guide.

For more Cognos information, see the Cognos Configuration User Guide.

Deploying Sterling Business Intelligence Reports
About this task

To deploy the Sterling Business Intelligence reports:

Procedure
1. Copy the SMCF-Analytics.zip deployment file from

<Sterling_Analytics_Installation_Directory>/deployment folder into the
deployment directory as specified in the Cognos Configurator. The default is:
<Cognos_8_Installation_Directory>/deployment.

2. Open Cognos Connection and launch IBM Cognos Administration.
3. Select Configuration and then Content Administration.
4. Select New Import.
5. Select the SMCF-Analytics deployment archive.
6. Enter a name for the import and select Next.
7. Select the Package name.
8. Continue through the prompts and run the newly created job.
9. Copy over the <ANALYTICS_HOME>/lib/sscap-auth.jar to

<Cognos_8_Installation_Directory>/C8/webapp/p2pd/WEB-INF/lib folder on
the machine where Cognos 8 has been installed. Similarly, copy the file
<ANALYTICS_HOME>/bin/analytics.properties.sample to the
<Cognos_8_Installation_Directory>/webapps/p2pd/WEB-INF/classes folder.

10. Save the file <Cognos_8_Installation_Directory>/webapps/p2pd/WEB-INF/
classes/analytics.properties.sample as analytics.properties in the same
folder.

11. Change the value of the sscap.app.url property to point to the Sterling
Selling and Fulfillment Foundation URL. For example:
sscap.app.url=http://hostname:port/smcfs
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Required Properties Modifications to Launch Analytics
To launch ReportNet® Analytics from the Application Console, you must configure
the analytics.reportnet.url property in the <INSTALL_DIR>/properties/
customer_overrides.properties file. For information about overriding properties
using the customer_overrides.properties file, see the Selling and Fulfillment
Foundation: Properties Guide.

The ReportNet Analytics URL format is:
http://<machinename>/cognos8/cgi-bin/cognos.cgi

Note: In the URL shown above, replace <machine_name> with the machine name or
the IP address of the Cognos 8 installation machine. Also, if you have changed the
reference URL for cognos using the Cognos Configurator, replace cognos8 with the
correct path.

Note: DO NOT change the other parts of this URL. The Analytics access from the
Sterling Selling and Fulfillment Foundation may fail.

You must also configure the analytics.namespace property in the
<INSTALL_DIR>/properties/customer_overrides.properties file. This property
indicates the namespace that is to be configured to authenticate users in Cognos 8
Business Intelligence.

For information about overriding properties using the
customer_overrides.properties file, see the Selling and Fulfillment Foundation:
Properties Guide.
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Chapter 3. Sterling Business Intelligence Framework

Sterling Business Intelligence Framework
The Sterling Business Intelligence Framework is the foundation where you build a
set of reports.

The Sterling Business Intelligence Framework contains a Data Model (see “Sterling
Business Intelligence Framework: Data Model”). Complete the following tasks to
utilize Sterling Business Intelligence for analysis and reporting:
1. Build reports (see “Sterling Business Intelligence Framework: Designing

Reports” on page 27).
2. Deploy, refresh, and optionally extend reports (see “Deploying Reports” on

page 45 ).

Sterling Business Intelligence Framework: Data Model
The Data Model is a metadata model that provides:
v A single administration point for metadata supporting Cognos 8 reports
v Centralized business rule definitions for maintenance and consistency
v Access to data from several different types of sources
v Expanded querying and reporting capabilities
v Centralized data access setup (permissions)

You can extend the basic Data Model to include other tables from the Sterling
Selling and Fulfillment Foundation Database.

For more details about extending the Data Model, see “Extending the Sterling
Business Intelligence Data Model” on page 47.

Star to Snowflake Model
In a normalized database, there are typically master tables and transactional tables.
The master table data is shared by many transactional tables, or a given
transactional table may have multiple columns as foreign keys for the same master
table. In a query, when this type of transactional table(s) are joined to the same
master table, the master table is repeated in the SQL query. For example:
SELECT ... FROM YFS_ORGANIZATION O, YFS_PERSON_INFO PI1, YFS_PERSON_INFO PI2,

YFS_PERSON_INFO PI3
WHERE O.CORPORATE_ADDRESS_KEY = PI1.PERSON_INFO_KEY (+) AND

O.CONTACT_ADDRESS_KEY = PI2.PERSON_INFO_KEY (+) AND O.BILLING_ADDRESS_KEY =
PI3.PERSON_INFO_KEY (+)

In this example, the Person Info master table has been repeated for each
referencing column. If the Organization table was joined to another table that had
more references to the Person Info table, you would see more Person Info tables in
the query.

In the Data Model, joins are created between the entities to represent the
relationships between them. Naturally, if a master table contains only one entity,
and more than one reference to it is needed in a particular query, the SQL that is
produced is not correct. For example:
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SELECT ... FROM YFS_ORDER_LINE OL, YFS_SHIP_NODE SN
WHERE OL.SHIPNODE_KEY = SN.SHIPNODE_KEY AND OL.RECEIVING_NODE =

SN.SHIPNODE_KEY .

This query is not correct. Therefore, in this case, you need two entities in the
Catalog that correspond to YFS_SHIP_NODE. This is done by replicating the entity
Organization Distribution Nodes into Organization Receiving Nodes and
Organization Ship Nodes. These are now joined individually to the Order Line's
columns above.

If more entities require the same set of master tables, the master tables can be
further replicated in the Catalog. For example, Organization Receiving Nodes and
Organization Ship Nodes are required both by Order Line and Order Release. So
there are two instances of each Node table in the Catalog.

Other tables may need to be similarly replicated. As this replication is extended for
more and more master tables, the Star model of the database begins to look like a
Snowflake. Figure 12 on page 23 illustrates this concept.
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Figure 12. Star to Snowflake Model
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Data Model Objects
The Data Model provides a simplified, English-oriented, non-technical view of the
metadata. In the Data Model, business entities are defined and information is
renamed to enable it to be represented using common business names and
grouped from a business perspective. The Data Model provides intuitive access to
the report building blocks. Using Tools> Modify Names, you can change the names
of the columns. This function provides a list of name rules that are run for these
entities. The Data Model has the following components:
v Filters
v Entities
v Joins
v Prompts
v Parameter Maps

Data Model Objects: Filters
A filter provided by the Sterling Selling and Fulfillment Foundation that is used to
narrow down the selected data. Filters are required for limiting access to data for
different classes of users.

A filter includes the data that is ‘filtered' (filtered in, not filtered out). For the
condition level detail of a filter, see the filter properties in the model. The SQL that
is formed in cases where a filter is applied contains the condition of the filter. The
filter that is provided:
v Sales Order – limits data to the Document_Type of 0001. Filters are also used in

conjunction with Parameter Maps to select the schema in a multi-schema
environment. For more about Parameter Maps, see “Data Model Objects:
Parameter Maps” on page 25.

Data Model Objects: Entities
The Data Model includes entities created in the model.

Entities Created in the Catalog

When a normalized database, typically represented as a star model, is modeled, it
is denormalized in the model to allow multiple joins in the same tables. That is, a
star model is expanded into a snowflake. (See “Star to Snowflake Model” on page
21.) Some of this denormalization is done in the Sterling Business Intelligence
Framework commonly joined tables, such as YFS_PERSON_INFO. Other entities
have been duplicated in the Data Model.

Data Model Objects: Joins
Joins are created in the Data Model. This reduces the maintenance overhead for the
model.

Cardinalities for Joins

The cardinality for the joins are specified in accordance with the database design
logic for the various entities. For example, An Order Header may not always have
a Carrier Service Code. Therefore, the cardinality for the Order Header join with
Organization Carrier is 0:1 on the Carrier side.

24 Sterling Selling and Fulfillment Foundation: Business Intelligence Operational Reports



Additionally, to allow flexibility in reporting, some of the joins have optional
cardinality (0:1 or 0:n). This is done so that, in a query, the main entity's data set is
not restricted by any lack of data. The Data Model allows changing of the optional
cardinality to a direct join at an individual report level. For example, see "Join
Cardinality Flexibility".

Join Cardinality Flexibility

The Item and Item Alias entities have a 1:1-0:n join in the business layer. When a
Cognos 8 report containing these two entities is created, it is as follows:
select T1."MANUFACTURER_NAME" as c1,

T2."ALIAS_NAME" as c2
from ("YFS_ITEM" T1 left outer join "YFS_ITEM_ALIAS" T2 on T2."ITEM_KEY" =
T1."ITEM_KEY")
--If we now uncheck the Report->Query->Access->”Include the missing table join
--values (outer join)” check box, the query changes to
select T1."MANUFACTURER_NAME" as c1,

T2."ALIAS_NAME" as c2
from "YFS_ITEM_ALIAS" T2,
YFS_ITEM" T1
where (T2."ITEM_KEY" = T1."ITEM_KEY")

However, if the join in the business layer was 1:1-1:n instead, the above flexibility
would not have been possible to achieve.

Data Model Objects: Prompts
A "Sales Order #" prompt is provided for selecting a single order based on Data
Model organization.

Data Model Subject Folders
The Data Model contains Subject Folders that group functionally related Subjects
together. This is done to easily locate the Subject Attributes needed to create
reports and queries. Some of the subjects contain sets of attributes that are further
grouped into subject folders for the same reasons. This creates a hierarchical folder
structure for easy lookup. Such subjects, called “Categorized Subjects”, have a
Subject Folder and a Subject by the same name.

Cases that use multiple categorized subjects are Order Release and the Order
Header folders. For more details about each subject, see the Data Model.

Data Model Objects: Parameter Maps
The Sterling Selling and Fulfillment Foundation supports multiple schemas in an
installation, separated by both table type (Configuration and Transaction), and
Enterprise Code. This multiple schema implementation of Analytics requires that
you select tables from the correct schema. A Cognos Datasource for each schema
facilitates this. The schema is then dynamically selected from the report via the
Enterprise selection screen shown in Figure 13 on page 26.

Within the Cognos Framework Manager, there are four data sources, based on type
of schema: Configuration, Metadata, MasterData, and Transaction. Data sources
within Framework manager are like pointers to the true data sources defined
within Cognos connection. Database Query Subjects are hard coded with one of
these four schemas. For a list of which tables are considered part of which schema,
see the Selling and Order Management Foundation Multitenant Enterprise Guide. For
Release 9.1, the Transaction and MasterData data sources will point to the same
schema.
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The parameter map shown in Figure 13 enables you to define a prompt. The Key
that is associated with that prompt will be required for input in reports; it will be
used when an Enterprise is selected in a report.

The input will then be consumed by other Parameter maps that map Enterprise
Code to Datasource and Schema. Parameter maps can be nested like this, with the
value of one map becoming the key to the next.

This parameter map would be configured in Cognos as pictured:

The prompt that is defined in the parameter map is put into reports. Prompts
defined in Framework Manager can be reused in Report Studio.

This feature does not support cross-schema unions. All reports are enterprise
specific.

Sterling Business Intelligence: Aliases
Sterling Business Intelligence has created the following aliases to eliminate any
loops in the joins:
v Audit Order Release (alias of YAF_ORDER_RELEASE_VW)

Figure 13. Parameter Map

Figure 14. Cognos Map
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v Audit Order Line (alias of YAF_ORDER_LINE_VW)
v Order Release Statuses (alias of YAF_ORDER_RELATED_

STATUSES_VW)
v Order Line Statuses (alias of YAF_ORDER_RELATED_STATUSES_VW)
v Order Release Ship Nodes (alias of YAF_ORGANIZATION_

SHIP_NODES_VW)
v Shipment Order Release (alias of YAF_ORDER_RELEASE_VW)
v Invoice Line (alias of YAF_ORDER_LINE_VW)
v Invoice Collections Charge Transaction (alias of YAF_ORDHDR_

CHARGE_TRANSN_VW)
v Invoice Shipment (alias of YAF_SHIPMENT_VW)
v Inventory Item Organization (alias of YAF_ORGANIZATION_VW)
v Inventory Cost Ship Line (alias of YAF_ORDER_LINE_VW)
v Inventory Cost Ship Order (alias of YAF_ORDER_HEADER_VW)
v Cost Receipt Inventory Item (alias of YAF_INVENTORY_ITEM_VW)
v Order Release Receiving Nodes (alias of YAF_ORGANIZATION_

SHIP_NODES_VW)
v Cost Receipt Distribution Nodes (alias of YAF_ORGANIZATION_

SHIP_NODES_VW)
v Cost Shipment Distribution Nodes (alias of YAF_ORGANIZATION_

SHIP_NODES_VW)
v Inventory Supply Distribution Nodes (alias of YAF_ORGANIZATION_

SHIP_NODES_VW)
v Inventory Demand Distribution Nodes (alias of YAF_ORGANIZATION_

SHIP_NODES_VW)
v Organization Hub (alias of YAF_ORGANIZATION_VW)
v Organization Distribution Nodes (alias of YAF_ORGANIZATION_

SHIP_NODES_VW)
v Cost Receipt Distribution Nodes (alias of YAF_ORGANIZATION_

SHIP_NODES_VW)
v Order Line Receiving Nodes (alias of YAF_ORGANIZATION_

SHIP_NODES_VW)

Sterling Business Intelligence Framework: Limiting Access to
Data

Creating filters and user classes limit access to data. Users' access to data in reports
is restricted in Cognos using filters that are associated with user classes. For
example, to allow various ship node users to see a common ship node report, you
can create a filter for each ship node user and associate it with the user class for
the corresponding user.

It is not necessary to create filters or user classes to start using Analytics. However,
it is strongly recommended that you set these up before you deploy the reports.
For details on how to set up Users and User Classes, see the Cognos Access
Manager documentation. For details on creating filters, see the Cognos 8
documentation.

Sterling Business Intelligence Framework: Designing Reports
Reports are created using Cognos 8. Please refer to the Cognos 8 documentation
for information about designing reports.
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Chapter 4. Reports for Sterling Business Intelligence

Reports for Sterling Business Intelligence
The following sample reports have been created using Cognos Report Studio and
are provided with the Sterling Selling and Fulfillment Foundation as examples:
v Backlog Summary Report
v Business Volume Report
v Days of Supply Report
v Goods in Transit Report
v Invoice Collections Report
v Open Order Report
v Orders on Hold Report
v Returned Products Report
v Top 10 Products Report
v Unshipped Orders Report

Report Studio is used to create reports having complex layout and formatting
requirements or reports that support user interaction. Report Studio should also be
used when you need detailed control over a report's appearance, when you are
producing a report intended for a large audience, or when you are producing a
report that exists long enough to require maintenance. If your report does not have
these requirements, you can use Query Studio, which provides a faster solution
and requires less technical expertise.

It is beyond the scope of this document to detail Report Studio and Query Studio.
Additional information can be found in the Cognos documentation located on the
Cognos Web site at www.cognos.com.

Accessing Sample Reports Provided with Sterling Selling and
Fulfillment Foundation

About this task

To access the sample reports provided with Sterling Selling and Fulfillment
Foundation, use the following procedure:

Procedure
1. Select Analytics → Launch Reports from the Application Console.
2. Select Public Folders from the Cognos Connection.
3. Select DOM from Cognos 8.
4. Double-click the report you need.

Backlog Summary Report
Operations managers may need information to help them identify bottlenecks in
their organization's fulfillment process. This information includes orders that have
been stuck in a particular status for a period of time. This information is necessary
to expedite the fulfillment process.
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The Backlog Summary Report provides visibility into sales orders that have been
in certain fulfillment statuses for a specific period of time. Figure 15 shows a
sample of the Backlog Summary Report. This report is parameter-driven to also
include the orders that are on hold. A pie chart displays the number of orders in
the following fulfillment statuses:
v Backordered: Orders that are in Backordered or an extended Backordered status
v Held: Orders that are on hold
v Pre-released: Orders that have not yet been released (does not include

Backordered orders)
v Released: Orders that are between Released and Shipped status (but are not yet

shipped)
v Shipped: Orders that are in Shipped or an extended Shipped status
v Other: Orders whose status does not fall into any of the other categories (this

does not include cancelled orders)

If an order is in both the Held status and another status, the report depicts that
order under the Held status only. For example, if an order is on hold and is also in
the Pre-released status, the order is included only with the Held orders.

The Backlog Summary Report should be run at night, during a period of light
load.

When entering the status name, it must match the name of the status in the system
exactly. For example, Pre-released status must be entered as Pre-released.

Figure 15. Sample Backlog Summary Report
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Business Volume Report
Business managers occasionally need to track the number of sales or the amount of
revenue generated by a particular seller.

The Business Volume Report provides visibility into the number of sales and the
amount of revenue generated during a specific period of time. Figure 16 on page
32 shows a sample of the Business Volume Report. For each day within a specific
time period, a graph displays the number of orders and order lines processed.
Another graph shows the revenue earned for each day. The sum of the total
amount of sales orders for each day determines the earned revenue. This report
only includes the non-draft sales orders for an enterprise whose order date falls
within the specified date range.

The Business Volume Report should be run at night, during a period of light load.
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Days of Supply Report
An inventory manager may need to know whether the supply is enough to meet
the demand, and on the average, how long the current supply will last.

Figure 16. Sample Business Volume Report
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The Days of Supply Report provides visibility into the estimated number of days
the inventory supply will be available, and the total supply and demand. Figure 17
shows a sample of the Days of Supply Report. For a specific enterprise and ship
node, the Estimated Days of Supply is calculated as:
Demand for the past 7-day period /7 = Average Demand
Current Supply / Average Demand = Estimated Days of Supply

The Estimated Days of Supply is rounded up and displays only two decimal
places.

The Days of Supply Report should be run at night, during a period of light load.

If there is no past week demand for an item, the Estimated Days of Supply is
shown in the report as 999.

Goods in Transit Report
A logistics manager may need to know which orders are dependent upon delayed
transfers or procurements. This information can also help to identify details about
the transfers that can delay orders. The transfers can be tracked to ensure timely
deliveries.

The Goods in Transit Report provides visibility into transfer orders and
procurement orders whose delayed shipment impacts the shipment of an outbound
order. You can run this report for procurement orders as long as they are:
v In Shipped but not Received status
v Are chained from a sales order
v Are overdue beyond the specified shipping threshold

The shipping threshold for a procurement order is the acceptable number of days
that the buyer is willing to wait for the shipment before it is considered overdue.
For example, a procurement order is shipped on the 3rd of December with a
specified threshold of 10 days. If the report is run on December 12th and the
procurement order hasn't been received, this procurement order does not appear
on the report because it has not been 10 days since it was shipped. However, if the
report is run on December 15th and the procurement order hasn't been received, it
appears on the report because it has been more than 10 days since it was shipped
and it has still not been received.

Figure 17. Sample Days of Supply Report
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Figure 18 shows a sample of the Goods in Transit Report.

Invoice Collections Report
A finance department employee may need to reconcile invoices with total
payments.

The Invoice Collections Report provides visibility into the total amount invoiced
and the total payments for each invoice type. Figure 19 shows a sample of the
Invoice Collections Report. For each payment pertaining to a specific invoice type,
the payment type and the amount collected for the payment type are displayed in
the report.

Open Order Report
The Open Order Report provides high-level visibility into unshipped orders
grouped by Enterprise, Buyer, and Requested Ship Date. This report is used by
operational users of the Sterling Selling and Fulfillment Foundation to provide
information about orders during the fulfillment cycle. Figure 20 on page 35 shows
a partial Open Order Report. This report is grouped mainly by Enterprise, Buyer,
and Requested Ship Date, and displays additional information in the columns. This
report only runs against the Sales Order document type (0001).

The Open Order Report should be run at night, during a period of light load.

Figure 18. Sample Goods in Transit Report

Figure 19. Sample Invoice Collections Report
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Orders on Hold Report
Businesses may try to guarantee same-day shipment for sales orders, purchase
orders, or transfer orders received by a certain time of day. Occasionally, an order
received by that time is placed on hold for some reason. In such cases, the
supervisor may want to know the percentage of orders that may potentially miss
the shipment deadline.

The Orders on Hold Report provides visibility into the number of sales orders,
purchase orders, and transfer orders that are on hold and unresolved. Figure 21 on
page 36 shows a sample of the Orders on Hold Report. A separate pie chart is
displayed for each type of order.

Figure 20. Sample Open Order Report
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This report also presents the details of the hold type. Click the Hold Type link to
see the details of that hold type in the Orders on Hold Details Report. Figure 22 on
page 37 shows a sample of the Orders on Hold Details Report.

Figure 21. Sample Orders on Hold Report
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Returned Products Report
A purchasing manager or shipment manager may need to assess and evaluate the
performance of suppliers, products, and sellers in terms of the number of returns
received.

The Returned Products Report provides visibility into the ten most frequently
returned items for an enterprise within a specific period of time, based on quantity.
This report includes items from non-draft return orders that are not service items.

This report does not filter for UOM or unit price. Therefore, if multiple items have
the same item identifier and description, but different UOMs, the items are treated
as the same item and the sum of the units sold for all of them is used. Likewise, if
multiple items have the same item identifier and description, but different unit
prices, the average unit price is used.

If multiple items have the same number of returns within the specified time
period, this report can list more than 10 items.

The Returned Products Report should be run at night, during a period of light
load.

Figure 23 on page 38 shows a sample of the Returned Products Report.

Figure 22. Sample Orders on Hold Details Report

Chapter 4. Reports for Sterling Business Intelligence 37



This report also presents the reasons for the return, and the percentage of returns
for each reason. Click the Item ID link to see the reason code and percentage of
returns for that reason in the Return Reasons per Product Report. Figure 24 shows
a sample of the Return Reason per Product Report.

Top 10 Products Report
Marketing and merchandising personnel make catalog and promotional decisions
based on the most popular products sold, and inventory analysts track products to
anticipate their shelf life.

Figure 23. Sample Returned Products Report

Figure 24. Sample Return Reasons per Product Report
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The Top 10 Products Report provides visibility into the 10 most frequently
purchased products within a specified time period. Figure 25 shows a sample of
the Top 10 Products Report. The 10 products included in a non-draft sales order
within a specific time period, that are not service products and have the highest
ordered quantity, are included in this report.

This report does not filter for UOM or unit price. Therefore, if multiple items have
the same item identifier and description, but different UOMs, the items are treated
as the same item and the sum of the units sold for all of them is used. Likewise, if
multiple items have the same item identifier and description, but different unit
prices, the average unit price is used.

If multiple items have the same quantity sold within the specified time period, this
report can list more than 10 items.

The Top 10 Products Report should be run at night, during a period of light load.

Unshipped Orders Report
Logistics managers may need to know the volume of shipments that their
company is expecting to ship on a particular day in comparison to the shipments
already shipped that day. Likewise, a store manager may need to track the number
of pending pickups for a certain store location for a particular day.

The Unshipped Orders Report provides visibility into the requested order releases
for a specific day. Figure 21 on page 36 shows a sample of the Unshipped Orders
Report. A pie chart displays the percentage of completed and the uncompleted
shipments.

Figure 25. Sample Top 10 Products Report
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Importing a Sample Report
About this task

Use this procedure to import a sample report.

Procedure
1. Open Cognos Connection.
2. Select Report Studio.

Figure 26. Sample Unshipped Orders Report
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3. Select File → Open. The Open dialog box is displayed.
4. Select a report.

Rules for Creating New Reports

The following rules should be followed when creating a new report:
v Never make changes to the Sterling Business Intelligence package, or add or

modify reports within it. From release to release, the Sterling Selling and
Fulfillment Foundation may provide new deployment files. These new files
supersede the previously released files in the Analytics package.

v To add new reports, open the Analytics package model in Framework Manager.
Rename the package (for example, SSC_NEWNAME_Analytics). Save this
package and publish it to the content repository.

v After publishing the renamed package, a new package folder (named, for
example, SSC_NEWNAME_Analytics) is created along with the previous Sterling
Business Intelligence on Cognos Connection. All new reports should be added to
the new package, and any changes to the model (for example, new or modified
query subjects) should also be made to the new package in Framework Manager.

Scheduling a Report
About this task

Cognos 8 Business Intelligence provides the ability to schedule reports using the
IBM Sterling Warehouse Management System application. A user can schedule
reports to run during lean periods. For example, a user can schedule reports
during off hours, when demands on the system are low.

To schedule a report in Cognos Connection:

Procedure
1. Open Cognos Connection.
2. Choose Public Folders.
3. Navigate to the folder that contains the list of reports.
4. Select the report that you want to schedule from the list.
5. Choose . The Schedule window displays.
6. Enter information in the applicable fields. For field value descriptions, see

Table 2.
7. Click OK.
8. Save the report.
9. Enter the parameter values.

10. Click Finish.

Table 2. Schedule Window

Fields Description

Frequency Choose the frequency at which you want to run the schedule.

Start Enter the time when you want begin the schedule.

End Enter the time when you want to end the schedule.

Options
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Table 2. Schedule Window (continued)

Fields Description

Format Select the appropriate format from the drop-down list in
which you want to display the report.

Delivery Choose the appropriate delivery option you want to use to
deliver the report.

Orientation Select the appropriate form of the report to display from the
drop-down list.

This is enabled only if the report is displayed in PDF format.

Paper Size Select the size of the paper from the drop-down list.

Languages Select the language in which you want to display the report.

Prompt for values Check this box to enter attribute values such as locale and so
forth.

Generating Reports from the Application Console
About this task

To generate a report, from the Sterling Selling and Fulfillment Foundation Report
Search console, click Generate Report. The system generates the report in any of
the following ways:
v By default, the system always generates the report.
v Displays a cached version of the report.

To view a cached version of the report, edit the <INSTALL_DIR>/properties/
customer_overrides.properties file and the following entry:
yfs.yfs.analytics.checkCachedReports=Y

If a cached version of the report is available, the system displays it. Otherwise,
the system generates it and displays it.
For information about viewing cached reports, see “Viewing Cached Reports
from the Application Console.”

Viewing Cached Reports from the Application Console
The Sterling Selling and Fulfillment Foundation enables warehouses to schedule
reports during lean periods and cache them in a Cognos content repository. If a
cached version of the reports is available, you can view the reports without
generating them each time.

To view the cached reports, you must save the report view in the following format:

Prefix the report name with parameter values sorted alphabetically and separated
by an underscore (_).
v If the parameter name has only one value, sort the parameter names

alphabetically in the ascending order and prefix the report name using the
parameter values.
For example, consider a report with two parameters, Enterprise and Zone, with
values E1 and A1 respectively. Sort the parameters in the ascending order
(Enterprise and Zone) and prefix the report name with values E1 and A1. When
you schedule a report, save the report as E1_A1_ReportName. When you run the
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report for Enterprise E1 and Zone A1, the system queries the Cognos content
repository for the E1_A1_ReportName report.

v If a parameter name has multiple values, first sort the values alphabetically, and
then sort the remaining parameter names.
For example, consider a report that takes the parameters Enterprise and Zone.
The value of Enterprise is E1. The values of Zone are A1 and B1. First sort the
values of Zone (A1 and B1), and then sort Enterprise (E1) in the ascending order
of the parameters, and prefix the report name using the values E1, A1, and B1.
When you schedule a report, save the report as E1_A1_B1_ReportName. When you
run the report for Enterprise E1 and Zones A1 and B1, the system queries the
Cognos content repository for the E1_A1_B1_ReportName report.
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Chapter 5. Deploying Sterling Business Intelligence Reports

Deploying Sterling Business Intelligence Reports: An Overview
To view the data, you must deploy reports and refresh them against your database.
The resulting reports allow you to analyze the data in various forms.

Refreshing Against a Replicated Versus a Transactional Database
The database impact of a refresh depends on the volume of data involved, refresh
frequency, and the design of the report “complexity”. Depending on your
requirements, you may have installed all Cognos components on a single machine,
1 to 2 machines, or a distributed setup. See the Cognos 8 Business Intelligence
documentation for more information. Your transactional database may be
co-located. You may need to refresh your database only during offpeak hours, or
have a “24/7” requirement for your system.

Some ad-hoc reports may need to be run hourly. Therefore, you must analyze your
deployment scenario and set up the refresh accordingly. It is recommended that
you refresh reports against a replicated database instead of your transactional
database. This allows you to configure and tune the replicated database for your
reporting needs, such as creating indices, keys on the tables, or tuning your
database parameters. You can replicate the transactional database using the
standard database replicating tools in the market. If you need to refresh against a
transactional database, keep in mind the performance impact on both the refresh
and the transactions of the Sterling Selling and Fulfillment Foundation that are
occurring in the database during the refresh period.

Deploying Reports
Refer to the Cognos 8 documentation for information about how to deploy reports
for Sterling Business Intelligence.

Remember to provide filter values for any reports that have filters, either for data
or security.

Creating a Suggested Folder Structure for Reports
About this task

We recommend the following steps to create your folder structure for report
deployment:

Procedure
1. Create a folder named "Staging" (or similar) under /<INSTALL_DIR>/

<ANALYTICS_HOME>.
2. Under the "Staging" folder create a folder named "Publish".
3. Under the "Publish" folder, create a folder for "Reports" where the reports that

are ready to be deployed are stored.
4. You can create additional folders under "Reports" to group reports. For

example, Finance or Marketing.
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Refreshing Reports
Based on the type of report deployed, the report could be either scheduled to
refresh at certain times, or is run at the time it is viewed (Burst Reports). See the
Cognos 8 documentation for more information about refreshing reports.
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Chapter 6. Extending the Data Model

Extending the Sterling Business Intelligence Data Model
The Sterling Business Intelligence Data Model can be modified to incorporate the
specific needs of your Sterling Selling and Fulfillment Foundation installation by
extending the Catalog.

For information about extending your Sterling Selling and Fulfillment Foundation
installation, see the Selling and Fulfillment Foundation: Customization Guide.

Before you extend the Data Model, read the Cognos 8 documentation so that you
understand how to use the product and you can apply that knowledge to the Data
Model. Be sure to create a backup of all components that are going to be modified.

The Data Model is extended by adding, deleting or renaming fields, tables, or
entities.

Extending the Sterling Business Intelligence Data Model: Adding
Fields and Tables

To add fields and tables, follow the instructions in the Cognos 8 documentation.

Extending the Sterling Business Intelligence Data Model: Deleting or
Renaming Fields and Tables

IBM recommends that you do not delete or rename the objects that already exist in
the Catalog delivered with Sterling Business Intelligence. This can create
compatibility problems with future versions of the Framework components.
However, if it is absolutely necessary to delete some objects, follow the guidelines
in the Cognos 8 documentation.

Editing the Sterling Business Intelligence Model
Following are conditions for editing the Sterling Business Intelligence model:
v Limited local processing should not be used during development unless

absolutely necessary. This enforces the practice of pushing all operations down
to the database, as opposed to pushing them to memory.

v Views should not be used unless all the following conditions are met:
– All tables in the view are in the same schema type, and will be for the

foreseeable future.
– All tables in the view are necessary; that is, there is no "might use" data

(example, Mark For Key on YFS_ORDER_HEADER).
– One of the following:

- The view is meant to be used as a stepping stone for query subjects and
has complex calculations.

- There is a combination of unions and group bys (some inventory use cases)
Some views may still be necessary as group-bys are not always enforced as
expected within Cognos, due to the aggregation logic it adds on its own.
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v All Query Subjects to be used in other query subjects should have their
relationships created manually with Filters. Columns and tables not directly
referenced may be "optimized" out of the SQL. Using Filters prevents this.

v Filters should be created for the organization code and other cross-schema
columns on the query subjects. The filter can contain the prompt. This pushes a
where clause down to the individual schema. For example, by filtering
enterprise code on order header, then only orders from the enterprise will be
read into memory.

v All filters should be created at the same level as relationships.
v Query Subjects should be grouped by schema type at the highest level.
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Chapter 7. Troubleshooting and Tuning

The Access Manager Is Not Working
About this task

To ensure that the Access Manager is running correctly:

Procedure
1. Make sure that the access manager is installed after the Netscape LDAP server

is installed, configured, and registered.
2. Configure the Cognos LDAP authentication using the same settings as that

used to configure the Sterling Selling and Fulfillment Foundation.
3. When registering the Access Manager using the Access Manager Wizard, use

the same information as in step 2.
4. If for some reason, the authentication is not working for the default namespace,

then uninstall the Access Manager, re-install LDAP, and re-configure with
proper parameters, re-register and then try connecting again.

SQL Net Connect String Error
About this task

If you get the error, "The SQL Net connect string shown on the Analytics catalog is
BLACKHOLE after installing the IBM Sterling Business Intelligence Framework on
a fresh server" when trying to open the catalog:

The catalog's available user classes do not correspond to any defined by the
Common Logon Server"

Follow these steps to ensure that the YAF-catalog can be opened:

Procedure
1. Launch Access Manager Administrator.
2. Select Root User Class and right-click,

v Select Add User Class
v Under the General tab enter "Creator" in the text box for Name.
v Select the Permissions tab and set the permissions for the Creator user class.
v Click the Apply button to save information.
v Click the OK button to return to the Access Manager Administration Tree.

3. From the Tree select the folder named Users.
v Select the user (default is administrator) that you would like to associate

with the user class, right-click and select the membership tab. Select the user
class that the user belongs to. In this case the Creator user class.
Alternatively you can associate the user by selecting the user named
Administrator, then drag it into the Creator user class.
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Results

An error occurs for any user attempting to log into the catalog who does not
belong to a specific user class.

Failed to Change User Class
About this task

If you get the error, "Failed to change the User Class. Unable to access the user
profile creator. Incomplete catalog login information for user class", when running
reports through the browser, you need to embed a user id and password in the
catalog.

To embed a database user id and password in a catalog:

Procedure
1. Open the catalog in Cognos 8.
2. Select Catalog → Profiles from the main menu.
3. Select the Database tab.
4. For each User Class, in the Database Security Options section, select Database

Logon and supply a database id and password.

Changing the Database Logon Type
About this task

To change the Database Logon type:

Procedure
1. Launch Report Administration.
2. Select the Report Project view.
3. Highlight the report set.
4. Select the User radio button in the Database Logon Type section.

Results

If the reports have already been published, delete them all and re-publish with the
change mentioned above.

Could Not Locate analytics.properties File Error
When performing custom authentication, if an error "Could not locate the file
analytics.properties in the classpath" displays, ensure that the
analytics.properties file is located in the correct path.

Tuning Sterling Business Intelligence Reports
Because all the reports for Sterling Business Intelligence are based on SQL
statements, tuning the SQL underlying the reports and sub-reports is
recommended. You can avoid complicated SQL reports by breaking the reports up
into sub-reports.
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Tuning Your Sterling Business Intelligence Installation
Tuning your Sterling Business Intelligence installation involves sizing the servers
where the installation is installed. For information, see “Cognos Server Sizing
Requirements” on page 53.

Unable to View Data in the Reports
About this task

If you are unable to view data in the reports, perform these tasks:

Procedure
1. Ensure that the URL of the Cognos Web site is added as a trusted Web site in

your browser.
2. Ensure that accept cookies are enabled in your browser.
3. Ensure that the value of the yfs.analytics.reportnet.url property in the

custom_override.properties file, for example,
yfs.analytics.reportnet.url=http://<machinename>/cognos8/cgi-bin/
cognos.cgi, does not contain extra space at the end.

4. Ensure that the value of the sscap.app.url property in the
analytics.properties file, for example, sscap.app.url=http://
hostname:portnumber/smcfs, does not contain extra spaces at the end.
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Chapter 8. Server Sizing Requirements

Cognos Server Sizing Requirements

Before you install the Cognos server-based products, ensure that you meet the
requirements as described in Table 3.

Table 3. Cognos 8 (IWR) Server Requirements

Characteristics Users

RAM

(# of Processes * RAM) Disk and CPU

8 catalogs

3 databases –
DB2, SQL Server,
Oracle

10 reports per
catalog

75% personnel,
25% public

200 users

10% concurrent
(20)

Users are
evenly
distributed
across catalogs.

PROCESSES

Not applicable -
dynamic

TOTAL RAM = 256 -
512MB

Memory for IWR= 256 –
512 MB

Memory for NT Server
= 70 MB

Memory for Web
Server= 5 MB

Memory for database
drivers

DISK SPACE

Temporary disk space
needed for report rendering
to PDF (5X final report size)
and final report storage.

Temporary disk space for
IWR= 1 GIG

IWR Software= 100 MB

Reports and Catalogs = 100
MB

NT Server = 500 MB

Database drivers

TOTAL Disk Space= 1.7 GIG

CPU

# of PROCESSORS = 1
scalable to 2

PROCESSOR = 200+ MHz
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Chapter 9. Cognos Components

Cognos Components
Cognos components consist of:
v Client and authoring components
v Server components
v Security components
v Tools

Most of these components are automatically installed with the main Cognos
components.

Cognos: Client and Authoring Components

Report Studio - used to build reports from the Sterling Business Intelligence
catalog (YAF-Analytics.cpf).

Analysis Studio - used to create ad-hoc cross-tab reports based on
multi-dimensional data sources.

Cognos: Server Components

Cognos 8 Reports - used to web-enable reports

Cognos: Security Components

Access Manager - used for user authentication

Others: Ticket server

Cognos: Tools

Cognos 8 Report Administrator

Cognos 8 Server Administrator

PDF Servers (for reports)

Access Manager Configuration Wizard

Other Server Administrator applications

Scheduler

© Copyright IBM Corp. 1999, 2011 55



56 Sterling Selling and Fulfillment Foundation: Business Intelligence Operational Reports



Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785

U.S.A.

For license inquiries regarding double-byte character set (DBCS) information,
contact the IBM Intellectual Property Department in your country or send
inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law

IBM Japan Ltd.

1623-14, Shimotsuruma, Yamato-shi

Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
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incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation

J46A/G4

555 Bailey Avenue

San Jose, CA 95141-1003

U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.
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This information is for planning purposes only. The information herein is subject to
change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© IBM 2011. Portions of this code are derived from IBM Corp. Sample Programs. ©
Copyright IBM Corp. 2011.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks

IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “Copyright and
trademark information” at http://www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States,
and/or other countries.

IT Infrastructure Library is a registered trademark of the Central Computer and
Telecommunications Agency which is now part of the Office of Government
Commerce.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or
registered trademarks of Intel Corporation or its subsidiaries in the United States
and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.
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Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

ITIL is a registered trademark, and a registered community trademark of the Office
of Government Commerce, and is registered in the U.S. Patent and Trademark
Office.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.

Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc. in the
United States, other countries, or both and is used under license therefrom.

Linear Tape-Open, LTO, the LTO Logo, Ultrium and the Ultrium Logo are
trademarks of HP, IBM Corp. and Quantum in the U.S. and other countries.

Connect Control Center®, Connect:Direct®, Connect:Enterprise™, Gentran®,
Gentran®:Basic®, Gentran:Control®, Gentran:Director®, Gentran:Plus®,
Gentran:Realtime®, Gentran:Server®, Gentran:Viewpoint®, Sterling Commerce™,
Sterling Information Broker®, and Sterling Integrator® are trademarks or registered
trademarks of Sterling Commerce™, Inc., an IBM Company.

Other company, product, and service names may be trademarks or service marks
of others.
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